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概要概要

このガイドでは、開発者が JBDS の Drools Tools プラグインを使用する方法を説明します。
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はじめに

1. ドキュメント規則

本ガイドでは、いくつかの規則を使用して特定の単語やフレーズを強調表示し、特定の情報への注意を
促しています。

1.1. 表記規則

特定の単語や句への注意を促すために 4 つの表記慣習を使用しています。これらの規則や、これらが適
用される状況は以下のとおりです。

等幅ボールド等幅ボールド

シェルコマンド、ファイル名、パスなど、システム入力を強調表示するために使用されます。キーと
キーの組み合わせを強調表示するためにも使用されます。以下に例を示します。

現在の作業ディレクトリーのファイル my_next_bestselling_novel の内容を表示する
には、シェルプロンプトで cat my_next_bestselling_novel コマンドを入力し、Enter
を押してコマンドを実行します。

上記には、ファイル名、シェルコマンドおよびキーが含まれます。これはすべて等幅ボールドで表示さ
れ、コンテキストにより区別可能なものになります。

キーの組み合わせは、各部分をつなぐプラス記号によって、個別のキーと区別できます。以下に例を示
します。

Enter を押してコマンドを実行します。

Ctrl+Alt+F2 を押して、仮想ターミナルに切り替えます。

最初の例では、押す特定のキーを強調表示しています。2 つ目の例は、同時に押す 3 つのキーのセット
というキーの組み合わせを強調表示しています。

ソースコードの場合、段落内で記述されるクラス名、メソッド、関数、変数名、および戻り値は、上記
のように 等幅ボールド等幅ボールド で示されます。以下に例を示します。

ファイル関連のクラスには、ファイルシステムの filesystem、ファイルの file、ディレ
クトリーの dir が含まれます。各クラスには、独自の関連付けられたパーミッション
セットがあります。

プロポーショナルボールドプロポーショナルボールド

これは、アプリケーション名、ダイアログボックステキスト、ラベルが付いたボタン、チェックボック
スおよびラジオボタン、メニュータイトルおよびサブメニュータイトルなど、システムで発生した単語
またはフレーズを示します。以下に例を示します。

メインメニューバーから System → Preferences → Mouse を選択し、Mouse
Preferences を起動します。Buttons タブで、Left-handed mouse チェックボックス
を選択し、Close をクリックしてメインのマウスボタンを左から右に切り替えます (マ
ウスを左手で使い易くします)。

特殊文字を gedit ファイルに挿入するには、メインメニューバーから Applications →
Accessories → Character Map を選択します。次に、Character Map メニューバーか
ら Search → Find… を選択し、Search フィールドに文字の名前を入力して Next をク
リックします。目的の文字が Character Table で強調表示されます。この強調表示し
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た文字をダブルクリックして Text to copy フィールドに配置し、Copy ボタンをク
リックします。ここでドキュメントに戻り、gedit メニューバーから Edit → Paste を
選択します。

上記のテキストにはアプリケーション名、システム全体のメニュー名および項目、アプリケーション固
有のメニュー名、GUI インターフェイス内のボタンおよびテキストなどがあります。すべては
proportional bold で示され、コンテキストと区別できます。

等幅ボールドイタリック等幅ボールドイタリック または プロポーショナルボールドイタリックプロポーショナルボールドイタリック

等幅ボールドまたはプロポーショナルボールドのいずれでも、イタリックが追加されると、置換または
変数テキストを意味します。イタリックは、状況に応じて変化するテキストや、文字を入力しないテキ
ストを表します。以下に例を示します。

ssh を使用してリモートマシンに接続するには、シェルプロンプトで ssh 
username@domain.name を入力します。リモートマシンが example.com で、その
マシン上でのユーザー名が john の場合は、ssh john@example.com と入力します。

mount -o remount file-system コマンドにより、指定したファイルシステムが再マウ
ントされます。たとえば、/home ファイルシステムを再マウントする場合、コマンド
は mount -o remount /home となります。

現在インストールされているパッケージのバージョンを表示するには、rpm -q 
package コマンドを使用します。これにより、package-version-release のような結
果が返されます。

上記の太字のイタリック体の用語、username、domain.name、file-system、package、version、および
release に注意してください。各単語はプレースホルダーで、コマンドの発行時に入力するテキストま
たはシステムによって表示されるテキストのどちらかになります。

作業のタイトルを示す標準的な使用法のほかに、イタリックは新用語と重要な用語の最初の使用を示し
ます。以下に例を示します。

Publican は DocBook 公開システムです。

1.2. 引用規則

端末の出力およびソースコードの一覧は、周りのテキストから視覚的に表示されます。

ターミナルに送信される出力は mono-spaced roman に設定され、以下のように表示されます。

books        Desktop   documentation  drafts  mss    photos   stuff  svn
books_tests  Desktop1  downloads      images  notes  scripts  svgs

ソースコードの一覧も mono-spaced roman に設定されますが、以下のように構文の強調表示が追加
されます。

static int kvm_vm_ioctl_deassign_device(struct kvm *kvm,
                 struct kvm_assigned_pci_dev *assigned_dev)
{
         int r = 0;
         struct kvm_assigned_dev_kernel *match;

         mutex_lock(&kvm->lock);

         match = kvm_find_assigned_dev(&kvm->arch.assigned_dev_head,

JBoss Enterprise SOA Platform 5 Drools Tools リファレンスガイドリファレンスガイド
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1.3. 注記および警告

最後に、3 つの視覚的スタイルを使用して、見落とす可能性のある情報に注意を促します。

注記注記

注記とは、タスクへのヒント、ショートカット、または代替アプローチです。注意を無
視しても悪い結果を招くことはありませんが、便利なヒントを見逃してしまう可能性が
あります。

重要重要

見落としやすい詳細のある重要なボックス: 現行セッションにのみ適用される設定変更
や、更新を適用する前に再起動が必要なサービスなどです。Important というラベルが付
いたボックスを無視しても、データが失われることはありませんが、スムーズな操作が
行えないことがあります。

警告警告

警告は無視すべきではありません。警告を無視すると、データが失われる可能性が
あります。

2. ヘルプの利用とフィードバック提供

2.1. ヘルプが必要ですか ?

本ガイドで説明されている手順で問題が発生した場合は、Red Hat カスタマーポータル
http://access.redhat.com にアクセスしてください。カスタマーポータルでは、以下を行うことができ
ます。

Red Hat 製品に関する技術サポート記事の知識ベースの検索または閲覧。

                                       assigned_dev->assigned_dev_id);
         if (!match) {
                 printk(KERN_INFO "%s: device hasn't been assigned before, "
                   "so cannot be deassigned\n", __func__);
                 r = -EINVAL;
                 goto out;
         }

         kvm_deassign_device(kvm, match);

         kvm_free_assigned_device(kvm, match);

out:
         mutex_unlock(&kvm->lock);
         return r;
}
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Red Hat グローバルサポートサービス (GSS) へのサポートケースの送信。

その他の製品ドキュメントへのアクセス。

Red Hat は、Red Hat のソフトウェアおよびテクノロジーについて、多くの電子メーリングリストも提
供しています。一般に公開されているメーリングリストの一覧
は、https://www.redhat.com/mailman/listinfoを参照してください。メーリングリストの名前をクリッ
クして、その一覧をサブスクライブするか、またはメーリングリストのアーカイブにアクセスします。

2.2. ご意見をお寄せください

本ガイドで誤字脱字を発見されたり、このマニュアルを改善するための提案をお持ちの場合は、弊社ま
でご連絡ください。JBoss Enterprise SOA Platform の製品に対して、Bugzilla:
http://bugzilla.redhat.com/ レポートを送信してください。

バグレポートを送信する際には、マニュアル識別子である 『Drools_Tools_Reference_Guide』 を指定
してください。

本ガイドを改善するためのご意見やご提案をお寄せいただく場合は、できるだけ具体的にご説明くださ
い。エラーが見つかった場合は、簡単に確認できるように、セクション番号と前後のテキストを含めて
ください。

JBoss Enterprise SOA Platform 5 Drools Tools リファレンスガイドリファレンスガイド
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第1章 はじめに

1.1. ビジネス統合

動的かつアジャイルなビジネスインフラストラクチャーを提供するためには、異なるアプリケーション
とデータソースが最小限のオーバーヘッドで相互に通信できるように、サービス指向のアーキテク
チャーを用意することが重要です。

JBoss Enterprise SOA Platform は、ビジネスプロセスの変更に対応するために、継続的に再利用する
ことなく、ビジネスサービスをオーケストレーションできるフレームワークです。JBoss Enterprise
SOA Platform では、ビジネスルールとメッセージの変換およびルーティング機能を使用することで、
複数のソースからビジネスデータを操作できます。

バグの報告

1.2. サービス指向アーキテクチャーとは

はじめにはじめに

SOA (Service Oriented Architecture) は単一のプログラムまたはテクノロジーではありません。ソフト
ウェア設計パラダイムと見なします。

すでに分かっているように、ハードウェアバス は、複数のシステムとサブシステムを結び付ける物理コ
ネクターです。これを使用する場合は、システムのペア間で多数のポイントツーポイントコネクターを
使用する代わりに、各システムを中央バスに接続するだけです。エンタープライズサービスバス (ESB)
は、ソフトウェアとまったく同じことを行います。

アーキテクトは、メッセージングシステムの上記のアーキテクチャー層にあります。このメッセージン
グシステムは、このメッセージングシステムを使用することでサービス間の 非同期通信 を容易にしま
す。実際、アーキテクトを使用している場合、すべてを概念的に、サービス （このコンテキストではア
プリケーションソフトウェア）またはサービス間で送信される メッセージ のいずれかです。サービス
は接続アドレスとして一覧表示されます (エンドポイント参照 と呼ばれています)。

このコンテキストでは、サービスは必ずしも Web サービスであるとは限らないことに注意することが
重要です。File Transfer Protocol や Java Message Service などのトランスポートを使用する他のタイ
プのアプリケーションもサービスになる可能性があります。

注記注記

この時点で、エンタープライズサービスバスがサービス指向のアーキテクチャーと同じ
場合は、妨げられる場合があります。回答は Not exactly です。 アーキテクトは、サー
ビス指向のアーキテクチャーを形成しません。代わりに、ツールを多数使用して構築で
きます。特に、SOA が必要とする loose-coupling および 非同期メッセージを渡すこと
が容易になります。SOA は常にソフトウェア以外のものと考えてください。これは一連
の原則、パターン、およびベストプラクティスです。

バグの報告

1.3. サービス指向アーキテクチャーの重要なポイント

以下は、サービス指向のアーキテクチャーの主要なコンポーネントです。
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1. 交換される メッセージ

2. サービスリクエスターおよびプロバイダーとして動作する エージェント

3. メッセージを送受信できるようにする 共有トランスポートメカニズム。

バグの報告

1.4. JBOSS ENTERPRISE SOA PLATFORM とは

JBoss Enterprise SOA Platform は、エンタープライズアプリケーションインテグレーション (EAI) およ
びサービス指向アーキテクチャー (SOA) ソリューションを開発するためのフレームワークです。これ
は、エンタープライズサービスバス (JBoss Warehouse) およびビジネスプロセス自動化インフラストラ
クチャーで設定されます。これにより、ビジネスサービスの構築、デプロイ、統合、オーケストレー
ションを行うことができます。

バグの報告

1.5. SERVICE-ORIENTED ARCHITECTURE PARADIGM

SOA (Service-ient Architecture)は、リクエスター、プロバイダー、およびブローカーの 3 つのロール
で設定されます。

サービスプロバイダーサービスプロバイダー

サービスプロバイダーはサービスへのアクセスを許可し、サービスの説明を作成し、サービスブ
ローカーに公開します。

サービスリクエスターサービスリクエスター

サービスリクエスターは、サービスブローカーが提供するサービスの説明を検索して、サービスを
検出します。リクエスターはサービスプロバイダーが提供するサービスにバインドするロールも果
たします。

サービスブローカーサービスブローカー

サービスブローカーは、サービスの説明のレジストリーをホストします。リクエスターをサービス
プロバイダーにリンクします。

バグの報告

1.6. コアおよびコンポーネント

JBoss Enterprise SOA Platform は、データ統合のニーズに対応する包括的なサーバーを提供します。
基本的なレベルでは、Enterprise Service Bus を介してビジネスルールを更新し、メッセージをルー
ティングすることができます。

JBoss Enterprise SOA Platform の中心となるのは、Enterprise Service Bus です。JBoss (ESB) はメッ
セージの送受信を行う環境を作成します。メッセージにアクションを適用して変換し、サービス間で
ルーティングすることができます。

JBoss Enterprise SOA Platform を設定するコンポーネントは複数あります。ESB とともに、レジスト

JBoss Enterprise SOA Platform 5 Drools Tools リファレンスガイドリファレンスガイド
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JBoss Enterprise SOA Platform を設定するコンポーネントは複数あります。ESB とともに、レジスト
リ (jUDDI)、変換エンジン (Smooks)、メッセージキュー (HornetQ)、BPEL エンジン (Riftsaw) が用意
されています。

バグの報告

1.7. JBOSS ENTERPRISE SOA PLATFORM のコンポーネント

完全な Java EE 準拠のアプリケーションサーバー (JBoss Enterprise Application Platform)

Enterprise Service Bus (JBoss ESB)

ビジネスプロセス管理システム (jBPM)

ビジネスルールエンジン (JBoss ルール)

オプションの JBoss Enterprise Data Services (EDS) 製品のサポート。

バグの報告

1.8. JBOSS ENTERPRISE SOA PLATFORM の機能

JBoss Enterprise Service Bus (ESB)

ドメインはサービス間でメッセージを送信し、それらを変換して、異なるタイプのシステムで処理
できるようにします。

Business Process Execution Language (BPEL)

Web サービスを使用して、この言語を使用してビジネスルールをオーケストレーションできます。
これは、ビジネスプロセス命令を簡単に実行するために SOA に含まれています。

Java Universal Description、、Discovery and Integration (jUDDI)

これは SOA のデフォルトサービスレジストリーです。ここで説明する内容は、インストラクター上
のサービスに関する情報をすべて保管する場所です。

Smooks

この変換エンジンは SOA と組み合わせて使用してメッセージを処理できます。また、メッセージを
分割して正しい宛先に送信するためにも使用できます。

JBoss ルールルール

これは、SOA にパッケージ化されたルールエンジンです。受信するメッセージからデータを推測し
て、実行する必要があるアクションを判別できます。

バグの報告

1.9. JBOSS ENTERPRISE SOA PLATFORM の JBOSSESB コンポーネント
の機能
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9

https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Instance+Name%3A+Not+Defined%0ABuild%3A+CSProcessor+Builder+Version+1.7%0ABuild+Name%3A+7094%2C+Drools+Tools+Reference+Guide-5-5.3.1%0ABuild+Date%3A+20-02-2013+16%3A28%3A25&cf_build_id=12943-364832+20+Feb+2013+16%3A28+en-US+%5BLatest%5D&short_desc=Core+and+Components&product=JBoss+Enterprise+SOA+Platform+5&component=doc-Drools_Tools_Reference_Guide&version=5.3.1
https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Instance+Name%3A+Not+Defined%0ABuild%3A+CSProcessor+Builder+Version+1.7%0ABuild+Name%3A+7094%2C+Drools+Tools+Reference+Guide-5-5.3.1%0ABuild+Date%3A+20-02-2013+16%3A28%3A25&cf_build_id=6504-366703+20+Feb+2013+16%3A28+en-US+%5BLatest%5D&short_desc=Components+of+the+JBoss+Enterprise+SOA+Platform&assigned_to=dlesage%40redhat.com&product=JBoss+Enterprise+SOA+Platform+5&component=doc-Drools_Tools_Reference_Guide&version=5.3.1
https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Instance+Name%3A+Not+Defined%0ABuild%3A+CSProcessor+Builder+Version+1.7%0ABuild+Name%3A+7094%2C+Drools+Tools+Reference+Guide-5-5.3.1%0ABuild+Date%3A+20-02-2013+16%3A28%3A25&cf_build_id=12945-365858+20+Feb+2013+16%3A28+en-US+%5BLatest%5D&short_desc=JBoss+Enterprise+SOA+Platform+Features&product=JBoss+Enterprise+SOA+Platform+5&component=doc-Drools_Tools_Reference_Guide&version=5.3.1


JBoss Enterprise SOA Platform の JBossESB コンポーネントは以下をサポートします。

複数のトランスポートおよびプロトコル

リスナーアクションモデル (これにより、サービスを相互に選択可能)

コンテンツベースのルーティング (JBoss Rules エンジン、XPath、Regex、および Smooks 経
由)

サービスオーケストレーション機能を提供するために JBoss Business Process Manager (jBPM)
との統合

ビジネスルールの開発機能を提供するために、JBoss ルールとの統合

BPEL エンジンとの統合。

さらに、新しいデプロイメントにレガシーシステムを統合し、同期または非同期で通信できるようにし
ます。

さらに、エンタープライズサービスバスは、以下を可能にするインフラストラクチャーおよびツール
セットを提供します。

さまざまなトランスポートメカニズム (電子メールや JMS など) と連携するよう設定されま
す。

汎用オブジェクトリポジトリーとして使用します。

プラグ可能なデータ変換メカニズムを実装できるようにします。

対話のロギングをサポートします。

重要重要

ソースコードには、org.jboss.internal.soa.esb と org.jboss.soa.esb の 2 つのツリーが
あります。org.jboss.internal.soa.esb パッケージの内容をそのまま使用します。これ
は、通知なしに変更される可能性があるためです。これとは対照的
に、org.jboss.soa.esb パッケージ内のすべての内容は、Red Hat の非推奨ポリシーでカ
バーされます。

バグの報告

1.10. タスク管理

JBoss SOA は、影響を受けるすべてのシステムで汎用的に実行するタスクを指定することにより、タ
スクを簡素化します。つまり、ユーザーは各ターミナルで個別に実行するようにタスクを設定する必要
はありません。ユーザーは、Web サービスを使用してシステムを簡単に接続できます。

JBoss SOA を使用して各マシンに複数回ではなく、ネットワーク全体でトランザクションを 1 回委譲す
ることで、時間を節約できます。これにより、エラーが発生する可能性も低くなります。

バグの報告

1.11. 統合のユースケース

JBoss Enterprise SOA Platform 5 Drools Tools リファレンスガイドリファレンスガイド
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ACME Equity は、大規模な経理サービスです。会社には多くのデータベースやシステムがあります。旧
式の COBOL ベースのレガシーシステムや、近年で小規模な企業で取得されるデータベースもありま
す。ビジネスルールが頻繁に変化するため、これらのデータベースを統合することは困難でコストがか
かります。会社は、クライアント向け e-commerce の Web サイトを新たに開発することを希望してい
ますが、現在使用している既存のシステムとは同期しない場合があります。

会社は、安価なソリューションを希望していますが、企業セクターの厳密な規制およびセキュリティー
要件に準拠するソリューションを検討しています。会社が望ましくないことは、レガシーデータベース
およびシステムを接続するために glob コードを作成および維持する必要があることです。

JBoss Enterprise SOA Platform は、これらのレガシーシステムを新しいお客様の Web サイトに統合す
るためにミドルウェアレイヤーとして選択されました。フロントエンドシステムとバックエンドシステ
ムの間のブリッジを提供します。JBoss Enterprise SOA Platform で実装されたビジネスルールは、す
ぐに簡単に更新できます。

その結果、SOA の統合方法により、古いシステムは新しいシステムと同期できるようになりました。1
カ月あたり数万のトランザクションであっても、ボトルネックはありません。XML、JMS、FTP など
のさまざまな統合タイプは、システム間でデータを移動するために使用されます。数多くのエンタープ
ライズ標準のメッセージングシステムの 1 つを JBoss Enterprise SOA Platform にプラグインすること
で、柔軟性を高めることができます。

さらに利点は、既存のインフラストラクチャーにより多くのサーバーやデータベースが追加されると、
システムを簡単にスケールアップできることです。

バグの報告

1.12. ビジネス環境での JBOSS ENTERPRISE SOA PLATFORM の使用

エラーメッセージが発生する可能性が低いサービスの実装により、コストを削減できます。生産性と
ソーシングオプションの強化により、継続的なコストを削減できます。

情報およびビジネスプロセスは、接続が増加するため、迅速に共有できます。これは Web サービスに
よって強化され、クライアントを簡単に接続するために使用できます。

レガシーシステムは Web サービスと組み合わせて使用して、異なるシステムが同じ言語にピークにす
ることができます。これにより、システムの同期に必要なアップグレードおよびカスタムコードの量が
減ります。

バグの報告
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第2章 はじめに

2.1. 本ガイドの対象者

本書は、セットアップで Drools Rules を利用する方法を学びたいシステム管理者を対象としています。
Drools Tools を使用して、Drools のプロセスとルールを作成、実行、およびデバッグする方法について
説明します。

バグの報告

2.2. ガイドの目的

このガイドは、Drools Rules パッケージを使用して基本的なタスクと複雑なタスクの両方を実行する方
法の概要をユーザーに提供することを目的としています。Drools プロジェクトの作成方法とルールのデ
バッグ方法について詳しく説明します。エディター、その使用方法、実行するタスクに関する情報もあ
ります。

バグの報告
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第3章 新しい DROOLS プロジェクトの作成

3.1. サンプル DROOLS プロジェクトの作成

1. 新しい Drools プロジェクトを作成するには、File → New → Project → Drools → Drools
Project をクリックします。これにより、New Drools Project wizard が開きます。

関連するフィールドにプロジェクト名を入力し、Next ボタンをクリックします。

2. サンプルルール、デシジョンテーブル、ルールフロー、およびそれらの Java クラスなど、デ
フォルトのアーティファクトのリストが表示されます。プロジェクトに関連するものを追加
し、Next をクリックします。

3. Drools ランタイムを指定するように求められます。まだ設定していない場合は、Configure 
Workspace Settings リンクをクリックして、今すぐ設定してください。

Drools ランタイムのワークスペース設定を行うことができる Preferences window が表示され
るはずです。新しいランタイムを作成するには、Add ボタンをクリックします。新しいランタ
イムの名前と、ファイルシステム上の Drools ランタイムへのパスを入力するように求められま
す。

注記注記

Drools ランタイムは、ファイルシステム上の .jar のコレクションであり、Drools
プロジェクトの .jar の特定の 1 つのリリースを表します。新しいランタイムを作
成するときは、選択したリリースを指定するか、Drools Eclipse プラグインに含
まれる .jar からファイルシステムに新しいランタイムを作成する必要がありま
す。

4. Drools Eclipse プラグインに埋め込まれた .jar から新しい Drools 5 ランタイムを作成できま
す。Create a new Drools 5 runtime ボタンをクリックし、ランタイムを作成するフォルダーを
選択して OK をクリックします。

5. 新規作成されたランタイムが Drools ランタイムの一覧に表示されます。これを確認して、OK
ボタンをクリックします。

6. Finish をクリックしてプロジェクトの作成を完了します。

7. これで、開始するための基本的な構造、クラスパス、サンプルルール、およびテストケースが
用意されました。

バグの報告

3.2. DROOLS プロジェクト構造の概要

新規作成されたプロジェクトには、src/main/rules ディレクトリーのサンプルルールファイル 
Sample.drl と、サンプル java ファイル DroolsTest.java が含まれています。これらは、com.sample
パッケージ内の src/main/java フォルダーの Drools エンジンでルールを実行するために使用できま
す。実行中に必要な他のすべての .jar も、Drools Library と呼ばれるカスタムクラスパスコンテナー内
のクラスパスに追加されます。

ヒントヒント:
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ヒントヒント:

ルールを Java プロジェクトに保持する必要はまったくありません。これは、すでに
Eclipse を Java IDE として使用している人々にとって便利なだけです。

バグの報告

3.3. 新しいルールの作成

1. 新しいプロジェクトを作成するには、空のテキスト .drl ファイルを作成するか、新しいルール新しいルール
パッケージパッケージ ウィザードを使用します。

2. ウィザードを開くには、File → New → Rule Resource を選択するか、ツールバーの JBoss
Drools アイコンのメニューを使用します。

3. ウィザードページで、ルールを保存する最上位ディレクトリーとして rules を選択し、ルール
名を入力します。次に、必須のルールパッケージ名を指定します。これにより、ルールをグ
ループ化する名前空間が定義されます。

4. ウィザードは、開始するためのルールスケルトンを生成します。

バグの報告

JBoss Enterprise SOA Platform 5 Drools Tools リファレンスガイドリファレンスガイド
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第4章 デバッグルール

4.1. ブレークポイント

ルールの実行がブレークポイントに到達するたびに、実行が停止します。実行が停止したら、その時点
で既知の変数を検査し、デフォルトのデバッグアクションのいずれかを使用して、次に何が起こるか
(ステップオーバー、続行など) を決定できます。Debug ビューを使用して、ワーキングメモリーとア
ジェンダの内容を調べることができます。

バグの報告

4.2. ブレークポイントの作成

1. Drools パースペクティブの Package Explorer ビューまたは Navigator ビューでブレークポイン
トを作成するには、選択した .drl ファイルをダブルクリックしてエディターで開きます。

2. .drl ファイルでルールブレークポイントを追加および削除するには、次の 2 つの方法がありま
す。

ブレークポイントを追加する行で Rule editor のルールをダブルクリックします。ルールを
もう一度ダブルクリックすると、ブレークポイントを削除できます。

注記注記

ルールブレークポイントは、ルールの結果でのみ作成できることに注意して
ください。ブレークポイントが許可されていない行をダブルクリックしても
何も起こりません。

ルーラーを右クリックします。コンテキストメニューで Toggle Breakpoint アクションを
選択します。このアクションを選択すると、選択した行にブレークポイントが追加される
か、すでに存在する場合は削除されます。

3. Debug perspective には、定義されたすべてのブレークポイントの表示、プロパティーの取
得、有効化/無効化、および削除に使用できる Breakpoints view が含まれています。Window
→ Perspective → Others → Debug をクリックして切り替えることができます。

バグの報告

4.3. デバッグ

1. Drools ブレークポイントは、アプリケーションを Drools アプリケーションとしてデバッグする
場合にのみ有効になります。これを行うには、次の 2 つのアクションのいずれかを実行する必
要があります。

アプリケーションのメインクラスを選択します。それを右クリックし、Debug As →
Drools Application を選択します。

または、Debug As → Debug Configuration を選択して、デバッグ設定を作成、管理、お
よび実行するための新しいダイアログウィンドウを開きます。

左側のツリーで Drools Application 項目を選択し、New launch configuration ボタン (ツ
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リーの上のツールバーの一番左のアイコン) をクリックします。これにより、最初に選択し
たメインクラスに基づいて、複数のプロパティーがすでに入力されている新しい設定が作
成されます。ここに示されているすべてのプロパティーは、標準の Java プログラムと同じ
です。

注記注記

デバッグ設定の名前を意味のあるものに変更してください。

2. 下部の Debug ボタンをクリックして、アプリケーションのデバッグを開始します。

3. デバッグを有効にすると、アプリケーションは実行を開始し、ブレークポイントが発生すると
停止します。これは、Drools ルールブレークポイントまたはその他の標準の Java ブレークポ
イントでもかまいません。Drools ルールブレークポイントが発生するたびに、対応する .drl
ファイルが開き、アクティブな行が強調表示されます。Variables ビューには、すべてのルー
ルパラメーターとその値も含まれます。その後、デフォルトの Java デバッグアクションを使用
して、次に何をすべきか (再開、終了、ステップオーバーなど) を決定できます。デバッグ
ビューは、その時点での作業メモリーとアジェンダの内容を決定するためにも使用できます (現
在実行中の作業メモリーが自動的に表示されます)。

バグの報告
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16

https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Instance+Name%3A+Not+Defined%0ABuild%3A+CSProcessor+Builder+Version+1.7%0ABuild+Name%3A+7094%2C+Drools+Tools+Reference+Guide-5-5.3.1%0ABuild+Date%3A+20-02-2013+16%3A28%3A25&cf_build_id=6831-291974+20+Feb+2013+16%3A28+en-US+%5BLatest%5D&short_desc=Debugging&product=JBoss+Enterprise+SOA+Platform+5&component=doc-Drools_Tools_Reference_Guide&version=5.3.1


第5章 エディター

5.1. DSL

ドメイン固有言語 (DSL) は、特定のドメイン内の問題を解決するために特別に作成された一連のカスタ
ムルールであり、ドメイン外の問題を解決できるようには意図されていません。DSL の設定はプレーン
テキストで保存されます。

バグの報告

5.2. DSL エディター

Drools では、DSL 設定は .dsl ファイルに保存されます。これらを作成するには、プロジェク
トコンテキストメニューから File → New → Other → Drools → Domain Specific Language を
選択します。

図図5.1 DSL エディターエディター

バグの報告

5.3. DSL エディターコンポーネント

表表5.1 DSL エディターコンポーネントエディターコンポーネント

第第5章章 エディターエディター
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コンポーネントコンポーネント Description

Description 特定の言語メッセージマッピングに関するユーザー
のコメント。

言語メッセージマッピングのテーブル このテーブルは、以下の 4 つの行に分割されていま
す。

Language Expression: ルールとして使用す
る式。

Rule Language Mapping: ルールの実装この
言語式のルールは、ルールエンジンコンパ
イラーによってコンパイルされます。

Object: オブジェクトの名前

Scope: ルールの条件部分、結果部分などの
場合、式が対象となる場所を示します。

行のヘッダーをクリックすると、クリックした行に
応じてテーブルの行をソートできます。行をダブル
クリックすると、言語マッピングの編集ウィザード
が開きます。

式 選択したテーブル行 (言語メッセージマッピング) の
言語式を表示します。

マッピング 選択したテーブル行 (言語メッセージマッピング) の
言語マッピングのルールを表示します。

オブジェクト 選択したテーブル行 (言語メッセージマッピング) の
オブジェクトを表示します。

Sort By このオプションを使用すると、言語メッセージマッ
ピングのソート順序を変更できます。これを行うに
は、ドロップダウンリストからソート方法を選択
し、Sort ボタンをクリックします。

JBoss Enterprise SOA Platform 5 Drools Tools リファレンスガイドリファレンスガイド
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Buttons
Edit: このボタンをクリックすると、言語
メッセージマッピングテーブルで選択した
行を編集できます。

Remove: このボタンをクリックすると、選
択したマッピング行が削除されます。

Add: このボタンを使用すると、新しいマッ
ピング行をテーブルに追加できます。

Sort: 詳細については、上の Sort By の行を
参照してください。

Copy: このボタンを使用すると、選択した
マッピング行からすべての情報がコピーさ
れる新しいマッピング行をテーブルに追加
できます。

コンポーネントコンポーネント Description

バグの報告

5.4. 言語マッピングウィザードの編集

1. このウィザードを開くには、言語メッセージマッピングのテーブルの行をダブルクリックする
か、Edit ボタンをクリックします。インスタンスの言語式、ルールマッピング、オブジェク
ト、およびスコープを編集できます。

図図5.2 編集オプション編集オプション

2. マッピングを変更するには、ユーザーは適切なオプションを編集し、最後に OK ボタンをク
リックする必要があります。

バグの報告

第第5章章 エディターエディター

19

https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Instance+Name%3A+Not+Defined%0ABuild%3A+CSProcessor+Builder+Version+1.7%0ABuild+Name%3A+7094%2C+Drools+Tools+Reference+Guide-5-5.3.1%0ABuild+Date%3A+20-02-2013+16%3A28%3A25&cf_build_id=6834-325400+20+Feb+2013+16%3A28+en-US+%5BLatest%5D&short_desc=DSL+Editor+Components&product=JBoss+Enterprise+SOA+Platform+5&component=doc-Drools_Tools_Reference_Guide&version=5.3.1
https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Instance+Name%3A+Not+Defined%0ABuild%3A+CSProcessor+Builder+Version+1.7%0ABuild+Name%3A+7094%2C+Drools+Tools+Reference+Guide-5-5.3.1%0ABuild+Date%3A+20-02-2013+16%3A28%3A25&cf_build_id=6835-375344+20+Feb+2013+16%3A28+en-US+%5BLatest%5D&short_desc=Edit+the+Language+Mapping+Wizard&product=JBoss+Enterprise+SOA+Platform+5&component=doc-Drools_Tools_Reference_Guide&version=5.3.1


5.5. 言語マッピングウィザードの追加

手順手順5.1 タスクタスク

1. Add ボタンをクリックすると、ダイアログボックスが表示されます。

2. 言語マッピングウィザードの詳細を適切なフィールドに入力します。

図図5.3 ダイアログボックスダイアログボックス

バグの報告

5.6. DROOLS FLOW EDITOR

1. ルールフローは、Eclipse 用の Drools プラグインの一部であるグラフィカルなフローエディ
ターを使用してのみ設定できます。Drools プロジェクトを設定したら、ルールフローの追加を
開始できます。プロジェクトをクリックし、File → New → Other... → Flow File を選択して、
ルールフローファイル (.rf) を追加します。

デフォルトでは、これらのルールフローファイル (.rf) は、グラフィカルなフローエディターで
開かれます。

2. Flow エディターは palette、canvas、および outline ビューで構成されます。パレットで作成
する要素を選択し、希望の場所をクリックしてキャンバスに追加します。

3. パレットの Select オプションをクリックしてから、ルールフローの要素をクリックする
と、Properties ビューでその要素のプロパティーを表示および設定できます。

4. Outline ビューは、一度にすべてのノードが表示されない複雑なスキーマに役立ちま
す。Outline ビューを使用すると、スキーマのパーツ間を簡単に移動できます。

バグの報告

5.7. フローパレットのさまざまなタイプのコントロール要素
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表表5.2 フローパレットのさまざまなタイプのコントロール要素フローパレットのさまざまなタイプのコントロール要素

アイコンアイコン 名前名前 Description

[D]

Select キャンバスでノードを選択しま
す。

[D]

マーキー 要素のグループを選択します。

[D]

シーケンスフロー キャンバスで 2 つの要素を結合し
ます。

バグの報告

5.8. フローパレットのさまざまなタイプのノード

表表5.3 フローパレットのさまざまなタイプのノードフローパレットのさまざまなタイプのノード

アイコンアイコン 名前名前 Description

[D]

開始イベント ルールフローの開始。開始ノード
は 1 つだけ指定できます。開始イ
ベントは着信接続を持つことがで
きず、1 つの発信接続を持つ必要
があります。ルールフロープロセ
スが開始されるたびに、ここで実
行が開始され、この開始イベント
にリンクされた最初のノードに自
動的に転送されます。

[D]

終了イベント ルールフローファイルには、複数
の終了イベントを含めることがで
きます。このノードには、1 つの
着信接続があり、発信接続はあり
ません。ルールフローで終了ノー
ドに到達すると、ルールフローは
終了します (並列処理が使用され
ている場合は、他の残りのアク
ティブなノードを含みます)。
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[D]

ルールタスク 一連のルールを表します。ルール
タスクノードには、1 つの着信接
続と 1 つの発信接続が必要です。
RuleFlowGroup プロパティーは、
一連のルールを表すルールフロー
グループの名前を指定するために
使用されます。ルールフローで
ルールタスクノードに到達する
と、エンジンは、対応するルール
フローグループの一部であるルー
ルの実行を開始します。このルー
ルフローグループにアクティブな
ルールがなくなると、実行は自動
的に次のノードに進みます。

[D]

Gateway[diverge] ルールフローにブランチを作成で
きます。Gateway[diverge] ノード
には、1 つの着信接続と 2 つ以上
の発信接続が必要です。

[D]

Gateway[converge] 複数のブランチを同期できます。
Gateway[converge] ノードには、
2 つ以上の着信接続と 1 つの発信
接続が必要です。

[D]

再利用可能なサブプロセス このルールフローからの別のルー
ルフローの呼び出しを表します。
サブフローノードには、1 つの着
信接続と 1 つの発信接続が必要で
す。実行する必要があるプロセス
の ID を指定するプロパティー
processId が含まれています。
ルールフローで再利用可能なサブ
プロセスノードに到達すると、エ
ンジンは指定された ID でプロセ
スを開始します。サブフローノー
ドは、他のサブフロープロセスが
その実行を終了した場合にのみ続
行されます。サブフロープロセス
は独立したプロセスとして開始さ
れます。つまり、このプロセスが
終了ノードに到達しても、サブフ
ロープロセスは終了しません。

アイコンアイコン 名前名前 Description
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[D]

スクリプトタスク このルールフローで実行するアク
ションを表します。スクリプトタ
スクノードには、1 つの着信接続
と 1 つの発信接続が必要です。実
行する必要があるアクションを指
定するプロパティー action が含ま
れています。ルールフローでスク
リプトタスクノードに到達する
と、アクションが実行され、次の
ノードに進みます。アクション
は、(有効な) MVEL コードの一部
として指定する必要があります。

アイコンアイコン 名前名前 Description

バグの報告

5.9. RULE EDITOR

Rule editor は、拡張子が .drl (または、複数のルールファイルにわたってルールを分散する場合
は、.rule) のファイルに対して機能します。エディターは、Eclipse の通常のテキストエディターのパ
ターンに従い、テキストエディターのすべての通常の機能を備えています。

バグの報告

5.10. CONTENT ASSIST

Rule editor で作業しているときに、Ctrl+Space を押すと、通常の方法でコンテンツのサポートを得る
ことができます。Content Assist は、現在のカーソル位置に使用できるキーワードをすべて表示しま
す。また、メッセージで使用可能なすべてのフィールドを提案します。

バグの報告

5.11. コードの折りたたみ

コードの折りたたみは、Rule editor で使用されます。エディターの左側の垂直線にあるマイナスとプ
ラスのアイコンを使用して、ファイルのセクションを非表示および表示できます。

バグの報告

5.12. OUTLINE VIEW との同期

Rule editor は、ルールの構造を表示する Outline view と同期して動作し、オブジェクトをファイルに
インポートし、ファイル機能を実行します。ビューは保存時に更新されます。数百のルールが存在する
ようなファイルで名前によるルールのナビゲーションを迅速に行うことができます。デフォルトでは、
アイテムはアルファベット順にソートされます。
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バグの報告

5.13. RETE TREE ビュー

Rete Tree ビューには、.drl ファイルの現在の Rete Network が表示されます。Rule editor の下部にあ
る Rete Tree タブをクリックするだけです。その後、現在の Rete Network 可視化を生成できます。
ノードをプッシュおよびプルして、最適なネットワーク概要を調整できます。

多数のノードがある場合は、フレームでそのいくつかを選択して、まとめることができます。現在の
ビューにすべてのノードが表示されていない場合は、Rete Tree をズームインおよびズームアウトでき
ます。これには、ツールバーのコンボボックスまたは + および - アイコンを使用します。

注記注記

Rete Tree ビューは、Drools Builder がプロジェクトプロパティーに設定されている
Drools Rule Projects でのみ機能します。

バグの報告

JBoss Enterprise SOA Platform 5 Drools Tools リファレンスガイドリファレンスガイド

24

https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Instance+Name%3A+Not+Defined%0ABuild%3A+CSProcessor+Builder+Version+1.7%0ABuild+Name%3A+7094%2C+Drools+Tools+Reference+Guide-5-5.3.1%0ABuild+Date%3A+20-02-2013+16%3A28%3A25&cf_build_id=7088-299167+20+Feb+2013+16%3A28+en-US+%5BLatest%5D&short_desc=Synchronization+with+Outline+View&product=JBoss+Enterprise+SOA+Platform+5&component=doc-Drools_Tools_Reference_Guide&version=5.3.1
https://bugzilla.redhat.com/enter_bug.cgi?cf_environment=Instance+Name%3A+Not+Defined%0ABuild%3A+CSProcessor+Builder+Version+1.7%0ABuild+Name%3A+7094%2C+Drools+Tools+Reference+Guide-5-5.3.1%0ABuild+Date%3A+20-02-2013+16%3A28%3A25&cf_build_id=7090-299167+20+Feb+2013+16%3A28+en-US+%5BLatest%5D&short_desc=Rete+Tree+View&product=JBoss+Enterprise+SOA+Platform+5&component=doc-Drools_Tools_Reference_Guide&version=5.3.1


付録A 更新履歴

改訂改訂 5.3.1-68.400 2013-10-31 Rüdiger Landmann
Rebuild with publican 4.0.0

改訂改訂 5.3.1-68 Wed Feb 20 2013 CS Builder Robot
コンテンツ仕様からビルド: 7094、リビジョン: 375347

付録付録A 更新履歴更新履歴

25


	目次
	はじめに
	1. ドキュメント規則
	1.1. 表記規則
	1.2. 引用規則
	1.3. 注記および警告

	2. ヘルプの利用とフィードバック提供
	2.1. ヘルプが必要ですか ?
	2.2. ご意見をお寄せください


	第1章 はじめに
	1.1. ビジネス統合
	1.2. サービス指向アーキテクチャーとは
	1.3. サービス指向アーキテクチャーの重要なポイント
	1.4. JBOSS ENTERPRISE SOA PLATFORM とは
	1.5. SERVICE-ORIENTED ARCHITECTURE PARADIGM
	1.6. コアおよびコンポーネント
	1.7. JBOSS ENTERPRISE SOA PLATFORM のコンポーネント
	1.8. JBOSS ENTERPRISE SOA PLATFORM の機能
	1.9. JBOSS ENTERPRISE SOA PLATFORM の JBOSSESB コンポーネントの機能
	1.10. タスク管理
	1.11. 統合のユースケース
	1.12. ビジネス環境での JBOSS ENTERPRISE SOA PLATFORM の使用

	第2章 はじめに
	2.1. 本ガイドの対象者
	2.2. ガイドの目的

	第3章 新しい DROOLS プロジェクトの作成
	3.1. サンプル DROOLS プロジェクトの作成
	3.2. DROOLS プロジェクト構造の概要
	3.3. 新しいルールの作成

	第4章 デバッグルール
	4.1. ブレークポイント
	4.2. ブレークポイントの作成
	4.3. デバッグ

	第5章 エディター
	5.1. DSL
	5.2. DSL エディター
	5.3. DSL エディターコンポーネント
	5.4. 言語マッピングウィザードの編集
	5.5. 言語マッピングウィザードの追加
	5.6. DROOLS FLOW EDITOR
	5.7. フローパレットのさまざまなタイプのコントロール要素
	5.8. フローパレットのさまざまなタイプのノード
	5.9. RULE EDITOR
	5.10. CONTENT ASSIST
	5.11. コードの折りたたみ
	5.12. OUTLINE VIEW との同期
	5.13. RETE TREE ビュー

	付録A 更新履歴

